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Overview 
QW6RS232 is designed to streamline RS-232 device integration into Quality Window 6 by providing 
both configuration and runtime tools. RS-232 is a long-standing serial communication standard 
that transmits data one bit at a time over defined signal lines, typically using DB9 or DB25 
connectors. Many instruments in manufacturing, laboratory, and quality control environments use 
RS-232 for reliable point-to-point data transfer. Examples include weight scales, torque testers, 
calipers, and specialized measurement gauges. This guide covers setup, testing, parsing, and 
optional scripting to capture data reliably from these supported devices. 

What is QW RS232? 
QW RS232 lets Quality Window communicate with devices over RS-232 and capture their output 
into variables (e.g., weight scales, torque gauges, barcode scanners, titrators, calipers). It includes 
two main components: 

RS232 Administrator  

Accessible via QW Admin in the Tools and Utilities section, the RS232 Administrator is used to 
configure RS-232 connections to devices and how values are captured for use with automated data 
collection in Quality Window. 

 

QW RS-232 Administrator Icon 

QW6RS232.exe Utility  

This component is used to trigger data collection in QW Applications using configurations created 
in RS232 Administrator. This utility can be found in the QW install folder typically C:\program 
files(x86)\Busitech\QW6  folder. 

 

Example RS-232 Data Collection Interface 
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Configuring Quality Window to Read RS-232 data 
The first step in configuring QW for RS-232 data collection, Busitech recommends that you first 
gather the manual for your device. The manual will be key in properly configuring your RS-232 
connection.  

RS232 Administrator – Device Settings 

When opening the RS-232 Administrator, you will be first presented with the Device Settings dialog. 
This dialog has two tabs, the general tab that enables the configuration of data collection properties 
and the Settings tab that manages the communication settings to your device. To start, select the 
Settings tab. If you want to edit an existing configuration (INI file) click cancel on the device settings 
dialogue to go straight to the administration console. 

Device Settings – Settings Tab 

On the Settings tab, start by selecting COM port and set communication settings based on the 
settings provided in your device manual. If you don’t have the manual you can contact the device 
manufacturer for further details. Busitech is unable to provide the settings for your specific device. 

 

Example of the Device Settings – Settings dialogue 

The following standard RS-232 communication settings are available: 

Connection Setting Description 
Port Number Your computer’s COM port that is connected to the device 
Baud Rate The device Baud Rate (from 75 to 128000) 
Parity Odd, Even, None, Mark, or Space 
Data Bits The number of data bits used (4 - 8) 
Stop Bits The number of stop bits used (1, 1.5, or 2) 
Handshaking Handshaking used (None, XonXoff, RTS, RTSXonXoff) 
Timeout The number of seconds of idle time to wait for a stream to complete 

 
Click General when done setting you initial settings. 
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RS232 Administrator – General Tab 

The General Tab provides the ability to set data collection settings such as sample count, send 
strings and device details. 

 

 
Example of the Device Settings – General dialogue 

 
 
On the General tab, enter the following information: 
 

General Property Description 
Device Name Give your device a descriptive name. This value will appear in the RS 

232 Input Title bar 
Init String Some devices require an initialization string to be sent to it when 

opening the port. Leave blank if not needed by your device. Supports 
mixed text and hex characters. 

Send String Command that asks the device to transmit its current value. Use hex 
escapes for control codes $0D and $0A which represents the hex 
values for CR and LF respectively. 
 
Leave blank if the device has a physical Print/Send key or streams 
automatically. 
 

Reset String Some devices require a string to be sent when closing the port. 
Leave blank if not needed by your device. 

Auto Send Auto-transmit Send String when the window opens (off for most 
devices). 
 

Auto Accept Auto-accept each received value; if off, the operator must accept/retry 
each entry. 

Advanced Shows a small debug window with received/transmitted bytes; helpful 
during setup. 

Min. Samples The minimum number of samples to be taken before the user can exit 
the program. 
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Max. Samples The maximum number of samples to be taken. If you wish to collect 
weights, and all 3 weights must be entered before returning to Quality 
Window, set Min to 3 and Max to 3. If you wanted to collect a maximum 
of 3 weights, but the number of weights collected is optional, then you 
set Min to 0 and Max to 3. 
 

Instructions These are operator instructions that will appear on the QW6RS232 
screen during collection. You can use the ‘|’ character to force line 
breaks 

 

 
Example of how certain properties impact the data collection screen 

 

After entering the above information, click on the OK button to continue to main administration 
screen and begin testing your connection. 
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Test communication 

Ready the device (e.g., place a weight on a scale). In the RS232 Admin, click Send to issue the Send 
String, or press the device’s Print/Send key if applicable. If you see no response or an error, recheck 
the port parameters, handshaking, cable type, and command string in the Device Settings dialog, 
accessible from the Edit -> Device Settings Menu. 

 

The lower pane shows the exact text returned, with ASCII and HEX views. Confirm the expected 
number formatting and the trailing <CR>/<LF> when present. 

 

Example of a lower pane containing data from RS-232 device 

Define fields (parse your value) 

Click the new field button to define a field to be extracted from the returned RS-232 data.  

 

New Field Button 

Now enter the following information to describe the field: 

Field Property Description 
Name Give your field a descriptive name - Example: Weight. This will also be the 

name of your IO file, so it is best to name this uniquely. 
Field Type If your field value is Numeric, then select Numeric 
Required Check this box if the field must be present in the string. This is useful when 

many fields are sent 
Max Value Enter the Maximum value that you should accept in this field 
Min Value Enter the Minimum value that you should accept in this field 
Absolute/Relative How to parse the data collected from the RS-232 device. 



QW RS232 Admin Guide - Subject 

 Page 8 of 16 
Aug. 14, 2025 

Absolute: highlight the exact character span to capture (click-drag over the 
value in the sample text). Works when the value always appears at the 
same position. 
Relative: specify an anchor string and offset/length relative to that anchor. 
Use this when the value shifts within the line. 
 

 

Set how your parse the data  

Fields can be parsed one of two ways: Absolute – specific position in the returned data or Relative 
– a position based on the location of a specific text value. 

Configuring Absolute Parsing 

To configure an Absolute approach, select the Absolute tab and use your mouse to  highlight the 
bounds of the value in the data preview. Make sure to consider the potential full value you want to 
capture. In the below example, the highlight is larger than the value to account for larger results. 
Releasing the mouse will commit this section as the area where data will be parsed. You cannot 
manually edit the start and length properties for absolute parsing, you must use the mouse to 
define the bounds. 

 

 

Example setting Absolute mode selection 

 

Configuring Relative Parsing 

If the value you want to parse shifts its position, a relative approach will likely permit you to parse 
the data consistently. To switch modes, click the absolute mode and ensure the Radio button 
beside the Find Text is selected. Now select your anchor text by clicking the text you want to anchor 
on. In the below example, the g is selected. 
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Example setting text anchor (Find Text) for Relative parse mode 

 

Next change your radio button to offset and use your mouse to highlight the desired value to 
capture. This will set the offset and length to the right values to capture this data based on the 
anchor. 

 

Example setting offset and length for Relative parse mode 

Once you have completed the two settings (Anchor, offset)  the data portal should show you your 
current settings with the anchor text in green, offset and length in red. 

 

Repeat this process for each field you want to define. Mixing relative and absolute configurations is 
supported. 

Configuring to capture multiple fields 

QW RS-232 can support capturing multiple fields with a single read of RS-232 data. In the below 
example, you have a value component (numeric) and a unit component (text) that can be split out 
into individual fields and be added to multiple different variables in Quality Window. Absolute and 
Relative fields can be mixed. 
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Weight Numeric Field Example 

 
Unit Text Field Example 

 

Save the configuration 

Choose File → Save As… and save the configuration INI in the same folder as your QW Application 
you wish to collect the RS-232 data in. If you want to use this INI file across many QW Applications, 
it can be saved in a central location. IO files generated from the data collection will be placed in the 
same folder as the INI file. 

Example: WeighScale.INI. 

 

Configuring the Quality Window Application 
Next, we need to configure the QW Application to prompt users with the data collection interface 
and map incoming values to specific variable. In QW Administration and open the Quality Window 
application via maintain application that you wish to collect RS-232 data into. 

Navigate to the General View tab and find Command to Execute in the Add Screen Options 
section. 
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The command to execute is made of two parts. The executable (QW6RS232.exe) and the path to the 
INI file that was created in the QW RS-232 Administration utility. 

Example:  

C:\Program Files (x86)\Busitech\QW6\QW6RS232.exe C:\Busitech\QW6\Sample 

Applications\Weigh Scale Interface Example\ScoutPro.INI 

Preparing the Variables in Quality Window 
The final step is to map your variables to the collected data from the RS-232 device. 

In the Variable View, select the variable(s) you will use to collect your data. 

Set input file to the name of the field(s) defined in QW RS-232 Admin and append an underscore 
with a sample index and an extension .IO. The IO file will be placed in the same folder as the INI file 
so ensure that if the INI is not in the same folder as the QW Application, a fully qualified path is 
used. 

Example: 

• Field Weight sample 1 → Weight_1.io 

• Field Weight sample 2 → Weight_2.io 

• Field Weight sample 3 → Weight_3.io 
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Example of a variable configuration for the first sample from RS-232 device 

Once the QW Application is configured save your changes and open the QW Application in QW 
workstation to test your solution. 

Capturing RS-232 data in a QW Application 
Click the add button in QW Workstation and if your solution is configured correctly, you should see 
a QWRS232 dialog like the following: 

 

 

Click the space bar to request data from the RS-232 device. If your RS-232 device has a print/send 
button, use this instead of the space bar. 



QW RS232 Admin Guide - Subject 

 Page 13 of 16 
Aug. 14, 2025 

If you configured to not Auto Accept values, the user will have to hit the check mark button or enter 
key to accept the collected data. ESC key or X to reject the collected data. 

 

Example of experience when auto accept is not enabled 

 

If the values are not being captured properly, you can enable advanced mode to see the raw data 
coming from the device. This may help in tuning your configuration. 

 

Example Advanced Mode 

 

 

Once you’ve collected all your samples, click ok to move to the Add screen and finish your current 
record. Your data should be pre-loaded into the appropriate variable(s). 

 

Example Add Screen with data from RS-232 Device 



QW RS232 Admin Guide - Subject 

 Page 14 of 16 
Aug. 14, 2025 

Troubleshooting tips 
• If no data arrives: verify COM port, cable type (straight-through vs. null-modem), 

handshaking (start with None), and that the device is actually transmitting (some require a 
poll command). 

• If gibberish appears: mismatch in Baud/Parity/Data/Stop. Match the device spec exactly 
(e.g., 1200, N, 8, 2). 

• If sporadic truncation: increase Timeout, adjust Min/Max Samples, or review handshaking. 

• Use Advanced mode to watch raw traffic while iterating on field parsing. 

Using Scripting for QW RS-232 
QW RS-232 Admin can generate a starter script (Edit → Generate Script). Copy it into your 
application script file. For a template named Monitor.qwt, create Monitor.qwx and paste/edit 
the assignments so each sample value from field Value(FieldNo, SampleNo) is written to the 
correct QW variable. 

Example assignments (replace variable indices with your schema): 

QWfile.Value(7) = RS232.Value(1,1)  'Weight Lane 1 

QWfile.Value(8) = RS232.Value(1,2)  'Weight Lane 2 

QWfile.Value(9) = RS232.Value(1,3)  'Weight Lane 3 

You may also launch QW6RS232 directly from script and bypass Input Files. Use QW6 object 
libraries only. 

Example: prompt operator to choose a device, then capture one sample each 

Option Explicit 

 

Function QW_BeforeDisplay(QWFunction) 

  Select Case QWFunction 

    Case "A"  ' Add Record 

      Dim oMenu 

      Set oMenu = CreateObject("QWTool60.Menu") 

      oMenu.Caption = "Select a Function" 

      oMenu.AddItem "1. Get Scale Value" 

      oMenu.AddItem "2. Get Torque Value" 

      oMenu.AddItem "3. Exit" 

      Do 

        oMenu.Display 

        Select Case oMenu.Selection 

          Case 1: GetWeight 

          Case 2: GetTorque 

        End Select 

      Loop Until (oMenu.Selection = 0) Or (oMenu.Selection = 3) 

  End Select 
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End Function 

 

Sub GetWeight 

  Dim RS232 

  Set RS232 = CreateObject("QWTool60.RS232") 

  With RS232 

    .Device      = "OHAUS Scale" 

    .Port        = 1 

    .PortSettings= "2400,N,7,1" 

    .Timeout     = 0.2 

    .InitString  = "" 

    .SendString  = "SA$0D"   ' S + CR; add $0A if device requires LF 

    .ResetString = "" 

    .AutoSend    = False 

    .AutoAccept  = False 

    .MinSamples  = 0 

    .MaxSamples  = 1 

    .DebugWindow = True 

    .Fields.Add "Weight", "N", "", 0, 7, 6, False 

    .Notes = "Place weight on scale and press Send" 

    .Display 

    If .Cancel = False Then QWfile.Value(3) = .Value(1,1) 

  End With 

  Set RS232 = Nothing 

End Sub 

 

Sub GetTorque 

  Dim RS232 

  Set RS232 = CreateObject("QWTool60.RS232") 

  With RS232 

    .Device      = "Imada Torque" 

    .Port        = 2 

    .PortSettings= "9600,N,8,1" 

    .Timeout     = 0.2 

    .InitString  = "" 

    .SendString  = "P$0D$0A" 

    .ResetString = "" 

    .AutoSend    = False 

    .AutoAccept  = False 

    .MinSamples  = 0 

    .MaxSamples  = 1 

    .DebugWindow = True 

    .Fields.Add "Torque", "N", "", 0, 1, 5, False 

    .Notes = "Press Send on Torque" 

    .Display 

    If .Cancel = False Then QWfile.Value(4) = .Value(1,1) 

  End With 

  Set RS232 = Nothing 

End Sub 
 

Notes 

• When scripting, do not configure Command to Execute or per-variable Input File properties; 
the script drives collection and assigns values directly. 
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• For .IO file workflows (no scripting), keep using Input File naming (Field_Sample#.io). 

 

 


